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1 Installing the TaxEditor 

Please refer to the TaxEditor User Manual part 1 (Installation and Updating) 

2 The EDIT Platform demos 

Please refer to the TaxEditor User Manual part 2 (Platform Demos) 

3 An introduction to the TaxEditor 

Please refer to the TaxEditor User Manual part 3 (TaxEditor Introduction and Tutorial) 

4 Working with the TaxEditor 

4.1 Understanding the structure 
It is important to understand how some terms are used in the context of the EDIT Platform and the 
TaxEditor and how they are related.  

The Classification is the uppermost hierarchical element in the Platform’s handling of taxa. Several 
classifications can reside in a single database. This is useful, for example, when there are alternative 
views on taxon circumscriptions (e.g. in the treatment of the general Hieracium and Pilosella in the 
Cichorieae, see http://cichorieae.e-taxonomy.net/).  
An accepted (correct) name nested within a classification designates a Taxon Node, representing a taxon 
in a given classification. If a taxon node is placed under a taxon of a higher rank, the latter is referred to 
as the Parent taxon, the former as the latter’s Child taxon. The position of the taxon within the 
classification is referred to as its Placement. 
A Taxon is a taxonomic group with the data that define its circumscription and describe its properties. 
The circumscription of the taxon is indicated by means of a circumscription or concept reference (“sec.-” 
or “secundum-” reference), normally a bibliographic reference clarifying the distinction of this taxon 
from other taxa. One and the same taxon may occur in several classifications, but it is also possible that 
two different taxa (taxon concepts) carry the same name in separate classifications. In themselves, 
classifications should be taxonomically consistent, i.e. every name should only occur once (as a taxon 
name or a synonym) in a given classification (except when cited as a misapplied name).  
The syn.-sec. reference indicates the reference that assigned the synonym to this taxon. 
Scientific names (as well as the names given to pseudotaxa) are assigned to records representing taxa, 
synonyms or misapplied names. Ranks of names follow the hierarchy defined in the nomenclatural 
codes. However, in the taxonomic hierarchy you are free to insert further nodes at any place in the tree 
thus forming new or mixed hierarchical levels – if these are not named according to the codes, we call 
them Pseudotaxa.  

http://cichorieae.e-taxonomy.net/
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4.2 Working with the Taxon Navigator 

4.2.1 Display 
The Taxon Navigator displays the classifications and, 
within those, a hierarchical tree of the contained 
taxon nodes, i.e. taxa. It won’t display synonyms or 
other non-accepted names. In its default position, the 
Taxon Navigator Window is the leftmost subwindow 
(“view”) in the TaxEditor interface. If you don’t find it, 
remember that you can call up windows using the 
Menu: Window –> Show view –> Taxon Navigator.  

You can change the order to alphabetical order of 
names in the Menu under Window –> Local 
Preferences -> UI -> Taxon Navigator. Please note that 
you have to close and open the Navigator window for 
the changes to take effect.  

  

The taxon tree is indented according to the sequence of ranks, e.g. all families are listed below their 
order. However, you are free to insert names independent of their ranks at any place in the tree, thus 
forming new or mixed hierarchical levels. For example, some classifications may not cite the species for a 
given subspecies. The subspecies is then assigned directly to the genus and displayed on the same level 
as the rest of the species. You can also insert preliminary groupings or “pseudotaxa”, such as species 
groups or clades. As a general principle, the program will alert you when it detects a deviation from 
nomenclatural rules, but it will not prevent you from entering the data you want to use.  

A double-click on a Taxon Node in the Taxon Navigator will open the Taxon Editor (see section below), a 
right click on a Taxon Node will open the context menu. 
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4.2.2 Context menu options in the Taxon Navigator 
The context menu provides an overview of the operations that can be carried out with the Taxon 
Navigator. Note that, although you are effectively selecting a Taxon Node in the tree, the operations are 
actually carried out on the underlying taxon (except when you add a new child taxon).  

• New allows to add a new child taxon to the selected taxon node or to create an entirely new 
classification. 

• Open in ... gives access to a number of editors that allow you to change data of the selected 
taxon or data connected to that taxon (see 4.2.3).  

• Change to synonym can only be carried out with taxon nodes that do not contain any child taxa.  
• Move taxon (with child taxa) allows to select a new parent taxon (you can do this also by using 

drag and drop). 
• Move factual data to another taxon allows to select a new taxon to which data such as the 

distribution, description etc. are to be linked. 
• Import allows you to add data from external sources in various formats.  
• Export allows you to export data and write them to a file in various formats.  
• Delete will remove the taxon node and – if not used elsewhere – the taxon and the name, in case 

you choose the respective options.  
• Copy creates a copy of the taxon node so that it can be pasted to another classification. 
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• Edit subtree offers several options in a sub-menu  
o Set publish flag for subtree allows you to 

set or unset the flag that determines if 
the affected names appear in output (e.g. 
on the portal). It affects all child taxa of the selected taxon and you can configure if 
synonyms are included.  

o Set secundum for subtree allows to change the sec.-reference for the selected taxon and 
all its child taxa. You can configure is syn.-sec. references are to be affected, too. 

o Aggregate distributions invokes an algorithm the calculates a distribution record for the 
selected taxon from its child taxa.  

• Refresh causes the Taxonomic Navigator being refreshed by loading all visible information from 
the data base. 

Secundum reference, publish flag, and taxonomic status flags can also be edited via the Taxon node edit 
dialog which can be opened by choosing Open in ...->Taxon node Dialog (see below), 

4.2.3 The Taxon node edit dialogue in the Taxon Navigator 
The taxon node edit dialog can be opened from the Taxonomic Navigator via the context menu  
Open in ...->Taxon node dialogue 

A different Taxon can be assigned to the taxon 
node here – but note that this feature is only 
used in treatments that use parallel 
classifications with shared taxa.  

The most important features of this dialog are 
related to the placement of the taxon node 
within the classification. While the placement 
itself is effected in the main Taxon Navigator 
view, here we can cite  the source of this 
placement (Placement source, with several 
details – see section 7 on bibliographic 
references). The placement may also be 
annotated with Placement notes.  
The Placement status defaults to the taxon being 
included into the parent taxon (the usual case). 
As in the example, it is then left blank. 

However, the Placement status allows to specify 
various modifications to that inclusion, up to an 
outright exclusion, and the reasons for that may 
be stated in the Placement notes.  

The different placement status assignations 
range from a doubtful inclusion to exclusion, the 
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latter can be made more explicit by 
specifying the reason (geographic – 
for example outside the range of a 
flora treatment; taxonomic – bearing 
the name of the parent taxon but in 
fact belonging to another taxon; 
nomenclatural – e.g. invalid 
designations, in case you don’t want 
to cite these with the synonymy). A 
name with a verified uncertain 
application is excluded for that 
reason. An unplaced taxon is one that is recognised as a taxon, but its placement is (still) unclear. 
Assigning the status of Unresolved name is practically an instruction to continue tracing the name’s 
correct application or placement status.   

In the main Taxon Navigator view, the placement status is indicated by a leading signs or characters (use 
Refresh in the context menu to make them visible after a new entry):  
 ‘?’ = included with doubts; the position in the tree remains unchanged; 
‘??’ = unplaced; 
‘ø’ = excluded (followed by ‘g’, ‘t’, ‘n’, or ‘a’ for geographic, taxonomic, nomenclatural exclusions or 
verified uncertain application, repectively); 
‘u’ = unresolved. 
Unplaced, excluded and unresolved taxon nodes are shifted to the end of the list.  

4.2.4 Adding a classification in the Taxon Navigator 
To add a classification, go to the Taxon Navigator and open the context menu of any Taxon Node with a 
right click. Choose -> New -> Classification. 

4.2.5 Moving taxa in the Taxon Navigator 
You can move a taxon (actually: a taxon node) and its child-taxa simply by drag and drop. However, in a 
large taxon tree this may be tedious.  
Alternatively, use the context menu: right click on the taxon you want to move, -> Move taxon (with child 
taxa), then select the classification you want to move the taxon to, and search for the parent taxon in 
the chosen classification. With OK the taxon will be moved and becomes a child of the taxon selected in 
the dialogue.  

4.2.6 Change the taxonomic status of a name 
Accepted to synonym: right click on the name in the Taxon Navigator. Select Change accepted taxon to 
synonym and select the accepted name.  

Synonym to accepted: Use the context menu of the synonym in the Taxon Editor: right click on the 
synonym => change to => accepted taxon. 
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4.3 General Search 
With the Search Function in the toolbar area of the TaxEditor you can search for scientific and common 
names in the database. Simply type a name into the textbox to the right of the save button and type 
<enter> or click on Search. 
The drop-down menu to the right 
can be used to restrict the search 
to certain categories of names, 
e.g. common names or types of 
scientific names (correct names of 
taxa, synonyms, names that have 
not been included in the 
classification, unpublished 
names). It also offers the choice 
of including the authors of 
scientific names. You can use the 
asterisk * as a wildcard, so, for example, the entry “* Mill.” will return all names that have Miller as the 
last author (if the With authors option is tagged).  

The search result appears in a subwindow below the Taxon Navigator.  

Names that are not part of a classification (i.e. that are not designated as a taxon name or as part of a 
synonym list) appear first and in larger script. A black square before the name indicates a taxon, a green 
circle a synonym. Both will take you to the respective taxon in the Taxon Editor upon double-click. A 
brown square is a taxon that is not assigned to a classification, this can be accessed only via the Bulk 
Editor. 

Search results with long result lists may take 
some time – have a look at the status 
displayed in the lower right corner of the 
TaxEditor.  
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4.4 Working with the Taxon Editor and its Details view  

4.4.1 Basics 
The Taxon Editor is the place where you can edit names, either directly or in the respective Details view, 
(to the right in the original Taxonomic perspective)1. It also serves to manage the synonymy of a taxon. 
The Details view (and other windows that initially open to the right of the Taxon Editor) will always show 
the atomised information for the name in focus, i.e. the taxon name or synonym you clicked on in the 
Taxon Editor subwindow.  
The subwindows that initially open below the Taxon Editor, such as Factual Data or Media, also refer to 
the name in focus, but that has to be the taxon name. When you set the focus to an item in these 
subwindows, the Details view and adjoined windows will show the information for that item.  

4.4.2 Linking the Taxon Editor back to the Taxon Navigator 
With the double-arrow in the upper right corner of the Taxon Navigator, you can 
establish a connection between the Taxon Editor and the Taxon Navigator. When it 
is enabled, the active taxon in the Taxon Editor will be selected in the Taxon 
Navigator. Note that currently this may have quite an impact on performance.  

4.4.3 Editing or adding a name in the Taxon Editor  
[To create a taxon, please use the context menu of the parent taxon in the Taxon Navigator.] 

To add a synonym, right-klick on the taxon to open the context menu: New -> Synonym (here you can 
directly choose the type of synonym you want to add, or choose to add a misapplied name) and <enter>. 
A new synonym line of the chosen type will appear. You can also simply put the cursor at the very end of 
an existing name and type <enter>. This will result in a line for a heterotypic synonym. You can change 
this to a homotypic synonym by dragging it to an existing name, thus adding it to a homotypic group. Use 
the context menu to change the synonym’s type. 
You can now type or paste the name into the empty synonym line. The program will attempt to parse 
the names entered here into their atomised components automatically. You can see the result in the 
Details view. Certain conventions have to be observed in order for the parser to work correctly: The 
name itself has to follow the rules and conventions of the Code of Nomenclature. For the nomenclatural 
references, add “in” after the standard author if the publication is an article or a book section, put a 
comma here if it is a book. And put the year in the end after a full stop. The parser will indicate 
whenever it has difficulties with the structure of a name or nomenclatural reference – a message will 
appear at the top of the Details view. 
NB: If the synonym’s name may already exist in the database, instead of typing you should choose the 
name in the Details view (avoiding to create duplicate names): click on the folder button in the Name 
section:  

 

1 The Taxon Editor has a little bug, that should be fixed in future versions. Meanwhile, please don’t edit a name 
directly in the Taxon Editor AND in the Details View at the same time. If you edited the name directly, switch to a 
synonym and back before making changes in the Details View (before being further edited, the Details View should 
be refreshed, which happens when the focus in the Taxon Editor changes). 
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In the dialogue box you can either choose a name or, if not found, enter a new one.  

4.4.4 The synonym list in the Taxon Editor 
The synonym list includes synonyms (homotypic and heterotypic), designations that are assigned to a 
taxon (e.g. invalid “names”), and misapplied names.  

In the Taxon Editor, synonyms are grouped together in case they have been designated as homotypic. 
Homotypic groups are separated by a horizontal line. You can assemble or disassemble a homotypic 
group by drag and drop. Please note that removing a name from a homotypic group will not 
automatically remove the basionym or replaced-synonym relationship , this has to be done separately in 
the Details view. 

Each individual synonym list entry starts with a symbol indicating its nature:  
o A homotypic synonym of the taxon name is indicated by an identity sign on a blue circle – dark 

blue if the respective name is the basionym or replaced synonym in the homotypic group of the 
taxon. 

o Heterotypic synonyms are indicated by dark or light green circles with an equal sign – their 
homotypic synonyms are again carrying an identity sign.  

o Invalid names or designations start with an en-dash in a green circle:  
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o Misapplied names (see below) start with MA in a purple circle:  

A misapplied name refers to a taxon in a defined publication that has been named erroneously (e.g. 
because the type of the name does not belong to the taxon).  
The publication (or group of authors – “auct.” if numerous) that misapplied the name is the “sensu” 
reference (Grisebach 1866 in the example); “non” designates the original author of the misapplied name 
(who’s concept does not apply to Grisebach’s), and the “err. sec.” reference points to the reference that 
establishes the misapplication and the assignation to the taxon’s synonym list. Technically, a misapplied 
name entry in the synonym list is a concept relation to a misnamed taxon concept .  

The context menu of a synonym list entry offers a number of options: 

o New adds a new synonym line and lets you identify the type of the entry (e.g. misapplied name,  
o Open in offers the possibility to edit the name in the Bulk editor (see section 6.4) or open the 

Referencing Objects view (a subwindow opening below the Details view showing all relationships 
of the synonym). 

o Change to offers the possibility to change the type of the synonym list entry, e.g. from synonym 
to misapplied name or pro-parte synonym.  

o Swap Synonym With Accepted does exactly that – name in source refers to the respective field of 
the references of factual data connected to the original name.  

o Set as Basionym is a shortcut to directly enter the respective name relationship 
o Move Synnonym .. changes the assignment for the entire homotypic group to a different taxon 
o Show Details opens the Details view in case it is not already open. 
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4.4.5 The Details view for scientific names - overview 
The Details view can be configured with various options, mainly to simplify its appearance. The one shown here is the one with (almost) all details enabled.  

 
Taxon (or Synonym) section: This section refers to the name in its classification 
context, with the sec.- or syn.-sec. reference and the respective Cache entry.  

______________________________________________________________ 

The further sections all refer to the name.  

(1) The Name itself (with its components according to rank – in this case a 
species), its standardised authorship and the possibility to mark it as a hybrid. 

(2) The standardised Nomenclatural source, with the Reference title that is 
maintained in a catalogue in atomised form and can be selected here, with the 
exact location in the publication (page number etc.) given in the Detail field; 
there is the possibility to specify an Original Spelling of the name in that 
publication, and one or more links to a website where an image of the reference 
of the nomenclatural Protologue/Original Publication can be consulted (e.g. in 
BHL) can be given. 

(3) The possibility to declare a Nomenclatural status for the name (e.g. “nom. 
inval.”, “nom. cons.”) with some details (see below),  

(4) Specification of the Type Information of the name (see below), and 

(5) Specification of Name Relationships (e.g. “is later homonym of”, “is replaced 
synonym for”) 
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4.4.6 Details view: access to catalogues 
Please refer to part 3 of the manual for an explanation of the elements and symbols used in the 
interface. Most importantly, remember that the Details view also lets you access the catalogues, i.e. lists 
of data items that may be used in more than one place (e.g. authors). Catalogues are accessed by the 
following buttons:  

 

The Browse existing (folder) button opens a search interface for existing 
data items in a catalogue 

 

The Edit button directly opens the entry and lets you change it. Use it with 
caution: with full rights the changes here will change all occurrences of 
the entry in the database! 

 

The Remove (garbage bin) button will remove the selected item from this 
record – it will not delete it from the database 

4.4.7 Further fields in the Details view 
Some of the fields in the Details view need further consideration:  

Caches: For an explanation of the Cache fields and the functionality of these, please look at manual 3 
section 4 and 5.  

The Appended phrase in the Taxon/Synonym section offers a possibility to add a non-standardised text 
to the name as used in this classification. It should not be used for the following purposes, which are 
supported in a standardised form: 

• “auct.” or “sensu ...” – these terms can be accommodated in the synonymy as misapplied names. 
If no original reference is given, “sensu auct.” is added automatically by the system. However, 
more specific designations, such as “sensu auct. mex.” may be placed here.  

• Secondary literature citations (parallel publications, e.g. Prodromus quarto and folio ed.). These 
should either be placed in the Details field of the nomenclatural reference or as a name fact, 
feature Additional Publication. 

The Appended phrase in the Name section should be used with even more caution and only for data that 
refers to the name, not for taxonomic information (e.g. “sensu lato” should not be used here, if 
necessary, use the Appended phrase in the Taxon section) 



 
User Manual - Working with the TaxEditor  

 

12 
 

Hybrid. Tagging a name as a Monom hybrid will insert the multiplication sign in front of the generic 
name, Binom hybrid in front of the species epithet, and Trinom hybrid in front of the infraspecific 
epithet. The term “notho” in rank designations is not used. It is currently not possible to enter a hybrid 
formula properly, i.e. using the parental names from the database. Input is affected by entering the 
formula as text in the Name Cache and tagging the name as Hybrid formula. 

4.4.8 Details View: Nomenclatural Source 
The Nomenclatural Source is the citation of the original publication of the nomenclatural act that led to 
the establishment of the name or designation.  

Note that the authors of the taxon are not connected to the authors of the publication, because these 
may be diffferent.  

The Original spelling gives the spelling in the source, in case this has been corrected. This is the selection 
of a name, so the name with the original spelling must be entered into the database. 

4.4.9 Details view: Nomenclatural Status 
The Nomenclatural status refers to the name, for example to its validity, in contrast to the taxonomic 
status of a name (synonym, correct). The status itself is selected from a vocabulary that can be adapted 
to the project in the Settings (see below).  

4.4.10 Details view: Name Relationships 
These refer to the name as well, so this does not include synonym relationships nor parent-child 
relationships. Examples are homonym relationships. Note that the relationship may imply a 
nomenclatural status for one of the names. However, the corresponding status (e.g. illegitimate for a 
later homonym) must be entered separately.  

4.4.11 Details view: Type Information 
Type information should always be entered only for the base name of a homotypic group, i.e. for the 
basionym or replaced synonym.  
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The nomenclatural type of a name of species-rank and below is a specimen, for higher ranks it’s a name. 
Accordingly, the data entry forms for types differ, you either select specimens or a name. In addition, 
there is the possibility to create a textual record, for example a copy of the text given in the original 
description. This is the reason why there are 2 data-entry “buttons” to the right of the Type Information 
section: the larger + leads to a form for specimen/name selection, the smaller +’ to a free text form.  

You can enter any text into the free text form, including longer statements about the search for a type 
etc. As usual, you can enter several such statements and individually ascribe them to a source reference: 

If the statement is marked as Is verbatim, output may format this in quotes.  

The form for selecting the type of a supraspecific name (e.g. a genus) lets you select a name from the 
names already entered into the database or, if necessary, add a new name. Note that in the case of a 
regional treatment, e.g. a Flora, this name may not occur in the taxonomic Classification, since the type 
species may not be present in the flora. This is one of the reasons for some names to exist only as names 
in the database. Type information for the genus name Achatocarpus: 

 

 



 
User Manual - Working with the TaxEditor  

 

14 
 

The form for species and below is similar, only that you select a specimen.  
In case the type category (Designation status) is lectotype or neotype, a designation reference (Status 
reference) may be given in addition to the Source of the information. 

Duplicates for entered type specimens can be added in the specimen Type Information dialogue by using 
the leftmost button to create a duplicate for the specimen (for which data items like herbarium location, 
accession number or barcode then need to be added). 

Nomenclatural types may be 
illustrations. In this case, a Media 
Specimen should be added and used. 
This section of the Platform is 
currently under Review. A 
workaround used presently is to fill 
the Title Cache field of a specimen 
with the citation of the image and 
protect the Title Cache. 
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4.5  Additional information referring to a name 
When you select a taxon name or a synonym in the Name-Editor window, additional windows like the 
Details view or the Supplemental Data view will show the data referring to the taxon or synonym. 

However, there are data items referring to the Name that are not displayed in the Details view. To see 
these items, e.g. in the Supplemental Data view, or to enter Name facts (in the Factual Data view), you 
have to set the focus to the underlying name. To do so, click into the white space directly under the 
Scientific Name heading in the Details view. The area will turn blue to indicate the special focus.  

Subwindows affected by the change in focus include Supplemental Data, Factual data, and Referencing 
objects. 
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5 Factual data 

5.1 Factual data sets, Features and Description elements 
Factual data are “descriptive” data items that can be linked to either taxa,  names (see 4.5 above) or oc-
currences (including specimens and other “derived units”,  see 6.5 below). Most factual data are visible 
and editable in the Factual Data view that initially opens below the Taxon Editor subwindow. Some can 
also be edited in a specific editor (e.g. area distributions), some (polytomous keys) only in their editor.  

For a given taxon, name, or occurence, a Factual data set contains the Description Elements (= the actual 
facts) that belong to a certain category (here called a Feature). In the example, “Distribution (General)” is 
the Feature, “Paraguay” is the Description Element. 

In the Details view, it is possible to define Sources (one or more References) and a Scope for the entire 
Factual data set. Several such sets can be created for one and the same taxon, name or occurrence. This 
is useful if data is entered from different sources (e.g. different local floras)  that should be kept separate 
for the time being. 

For every Feature it is defined for what it is available - taxon, name or occurrence. This in turn 
determines where it is shown as an option in the Factual Data view, for example, a Feature that is 
available only for taxa will not show up when the focus is on a name.  
The type of data the Feature supports is also part of its definition. Options include Text data, 
Quantitative data, or, more specifically, area distribution data, among others. This defines what can be 
entered in the Details view for a particular Description element belonging to that Feature. 

With the focus set accordingly, additional data can be entered in the Details view for the entire Factual 
data set and for the individual Description Element. All Description Elements can also be referenced 
individually to a Source. With the source entry, the name originally used in the respective publication 
may be specified, as it may differ from the accepted name in our treatment (see also section 7 on 
references). 

As elsewhere in the Platform, you can use HTML formatting in text fields: for example, in the text of a 
note, if you start a species name with <i> and end it with </i>, it will show up as italics in the portal and 
print output.  

A number of pre-defined features come with the basic installation of the Platform. However, you are 
free to define further ones for your project. In the following, some examples are given for the handling 
of factual data.  
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5.2 Features for simple text-type factual data 
In simple text-type Features, the Description Element consist of a single piece of text, such as a common 
name, a summary statement on the ecology, or a note. This may be accompanied by some contextual 
information like language or scope (for example, the language of a common name and the geographical 
area where it is used). This contextual information may be standardised, so that the entry is a choice 
from a selection list (e.g. for languages).  

 

. 

 

 

  

5.3 Area distribution using the Factual Data view 
Distribution by geographical areas is based on controlled vocabularies that may be created and 
maintained in the Term Editor (see section 13.1) (NB: the standard Feature “Distribution (General)” is of 
the simple text type. 

Area input is either handled through the Distribution editor (see section 5.4below) or, one by one, in the 
Factual Data window of the Taxon Editor. The Details view of a Description Element belonging to the 
Feature Distribution (Area) shows the area name and allows to specify a Distribution Status according to 
a controlled vocabulary as welle as source reference.  
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Have a look at the map in the Details view when you click on Distribution (areas) in the Factual Data 
window. The area distribution map computed from the entered data shows up – this is the same one 
that is visible in the Portal.  

5.4 Editing area distributions with the Distribution Editor 
To work with the Distribution Editor, it has 
to be activated  under Window-> Local 
Preferences -> UI2 -> Distribution Editor by 
selecting Enable for Enable Distribution 
Editor. 

Here you find a number of options that 
may greatly facilitate the work with the 
editor. For example, if you are familiar 
with the area and status codes used in 
your database, it is a good idea to set the 
Display of areas in the header and Display 
of status in the table to id or symbol. That 
will greatly reduce the width of your table. 
You can also permanently disable the rank 
column for the same reason3.  

 

2 UI = User Interface 
3 The Synonyms column will be made configurable, too. 
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The Distribution Editor is opened from the context menu of the respective taxon in the Taxon Navigator. 
The advantage of this editor as compared to the Factual data view is the possibility to edit a number of 
taxa at the same time in a spreadsheet-like table. To allow a full view of that table, it is useful to close all 
other subwindows, including the Details view and Taxon Navigator.   

Below the example of the genus Buxus from the Flora de la República de Cuba. Display of rank is 
disabled, both area names in the header row as well as the distribution status are set to display the short 
labels defined for the Flora. The first column lists all taxa belonging to (included in) the name selected in 
the Taxon Navigator, the second lists the syonyms,  and the subsequent columns are the areas with the 
distribution status – if present – entered for each taxon.  

Use the second line of the table to set filters for a specific status, if desired4. 

With Choose Source in the top right you can pre-set a reference for the entries made.  

Distribution Areas to the left of that opens the Distribution Selection Wizard 

 

4 The temporary hiding of colums in the second line is not yet available in the current release (5.32.0). 
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The Distribution Selection Wizard 
can be used to select the area 
vocabularies that are used in the 
editor. The actual vocabulary is 
usually preset for the entire 
database (here: “Checklist 
areas”). However, if you are 
entering data relevant to only a 
part of the list, this is usefull 
because it simplifies the table.  

 

You can use the buttons 

 to toggle the selection 
for a parent area and its direct 
children or for the parent area 
and all children at the same time.  

 

Clicking into an individual cell in the Distribution Editor provides access to a list of occurrence status 
terms, so that you can set the occurrence 
status of the taxon in the respective area.  
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5.5 Polytomous identification keys 
Polytomous keys keys are constructed using textual leads, they are not base on atomised descriptive 
data and thus they are static. The leads in the key, however, link to the taxa in the database.  

5.5.1 Opening the Polytomous Key Editor 
To work on keys, use the menu Window -> ShowView -> Polytomous Keys to open the respective 
perspective.  

 

All such semi-structured keys that have been created in the database will be listed in the subwindow to 
the left. Selecting one of them will display the Polytomous Key Editor with the respective Details view:  

 

5.5.2 The Polytomous Key Editor user interface 
The basic layout is somewhat analogous to setup of the Taxonomic perspective, with a “Key navigator” 
to the left, the key leads in the central area (Lead Editor), where you can also add leads to the key or 
delete them, and the Details view to the right.  

In the Details view, there are two sections, the top one refers to the entire key, the lower one to the 
specific lead (Key Node) that has the focus in the Lead Editor. 
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5.5.2.1 Items for the entire key 

Title: Name of the Key – will display as the title in the output 
and is listed in the „Key Navigator“. 

Start Number: The number assigned to the root of the key – 
normally „1“, but may be changed in special cases.  

Taxonomic Scope: one or more taxa covered by the key (more 
than one taxon may be useful e.g. if two genera are included 
that do not have a common parent in the classification).  

GeoScope: The area covered5.  

Scope Restriction: a further restriction of any kind, e.g.  of the 
taxonomic and/or geographic scope of the key, for which a 
vocabulary can be defined in the Term Editor under Modifier-
Scope. For example: Tree species / Mountain habitats.  
 

The source reference for the key and 
additional notes on its content can be 
entered in the Supplemental Data 
view under Annotations and Sources, 
respectively:  

 

 

 

 

 

 

 

The portal places these directly 
below the key’s title:  

  

 

5 Not yet implemented in the portal 
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5.5.2.2 Items for the Key Node: 

Node Number: the next lead in the key, in case that the lead does not directly refer to a taxon. 

Question (optional): a free text question (e.g. 
“Petal colour?) that is anwered by the 
Statement (e.g. “red”) 

Character: (relevant for automatically 
generated keys from two-part descriptive 
datasets (Character/Character state matrices): 
the character is displayed under 
Question/Character, the state options under 
Statement.   

Statement: An anwer to the Question, or a 
stand alone statement (“petals red”) forming 
the lead to the next node in the key or directly 
to a taxon. Alternatively, the character state 
option from a two-part descriptive dataset.6 

Taxon: the target taxon. If several taxa are 
targeted, separate leads with (otherwise) the 
same content have to be created. The Portal 
renders such duplicated leads correctly.  

Subkey: A lead may refer to another key. May 
be stated in parallel to a taxon, for example, if 
the key to species refers to a subkey to 
subspecies of that species.  

Other Node: Similar to Subkey, but here a lead in the key is referenced, not the root as in the Subkey 
option. This also allows to create a link to another node in the same key, in case that one already has 
another parent node (i.e., the lead is referenced from more than one parent lead).  

Modifying Text: a supplemental text, inserted in front of the target taxon, e.g. „mostly“, „only in 
Borneo“.  

 

6 Implementation of Media option is planned 
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5.6 Specimens 

5.6.1 Introduction 
The EDIT Platform is a software suite for taxonomic research and research results; it is not a collection 
management system. In contrast to the latter, as a rule only taxonomically scrutinised specimens are 
introduced into a Platform database (or at least it is the aim to have only such quality data present). 
These may stem from many different collections. The Platform also lacks typical collection management 
features such as loan management, curation details, etc. 

In the underlying Common Data Model (CDM), specimens are treated as part of a derivation tree that 
may include various objects such as DNA- and tissue-samples, sequences, duplicate specimens, 
cultivated living specimens, etc., but also observations (human observation, machine observation). The 
tree is rooted in what we call a Field Unit, which is in our case the organism in the field with the 
respective collection or observation event data. All Derived Units can be traced back to the Field Unit.  

This is a rather complex structure since all these “units” can have various complex other data objects 
attached to them (images, morphological descriptions, etc.). So speciments or occurences may be factual 
data and they may have factual data assigned to them. Moreover, the specimen data themselves are far 
from simple (the ABCD standard lists hundreds of data items that can be used to characterise a specimen 
– and this does not include morphological descriptors).  

This long introduction serves to explain why there are several ways to add and edit specimens in the 
TaxEditor (and also to explain why some of them still need a bit of work on the software development 
side to make them user-friendly).  

5.6.2 Options for specimen data entry 
The different possibilities for specimen data entry: 

• As a type specimen fromn the name Details view: see section 4.4.11. 
• Using the specimen Bulk Editors (tree) or (list): see section 6.5 below. 
• Starting in the Factual Data view: see 5.6.3 below. 

Which option to use depends on the context – a type is best edited in the corresponding context; this 
also allows to enter duplicates rather efficiently.  

5.6.3 Editing or entering specimens as factual data 
To be able to use the feature “specimen” in the factual data view, this feature has to enabled and to be 
configured to accept structured specimen data (see 13.1.3 below).  
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With the feature established and configured, specimen data can be added and edited from the Factual 
Data view of a taxon opened in the Taxon Editor: 

As usual in the Details view, you can use the Select 
and Edit Buttons.  

Edit opens the General Specimen Data form where 
both, Field Unit and the respective derived unit 
data can be edited. 

The items down to the Collection line belong to the 
Field Unit and are thus potentially shared with 
duplicates of the specimen. Currently no warning is 
displayed; make sure that you don’t accidentally 
edit data you did not intend to change.  

If you copy the Latitude / Longitude fields from a 
text using geographical (NSEW-) coordinates, for 
the time being please pay attention that you get 
the straight quotes for minutes and seconds (not: ‘ 
and “). 

As usual the Title Cache field can be used (when 
protected) to hold atomised textual data. However, 
the somewhat tedious data entry for specimen 
date pays off, for example, in the ability to create 
maps from coordinate data, search for collectors, 
etc. 
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5.7 Images 
Images are Media items and these are not stored directly in the CDM database. Instead, they have to be 
available under an Internet address (URI) to become part of CDM data. Since images can be attached to 
a number of database objects (Taxa, Specimens, morphological characters, etc.), their handling differs 
from that of other factual data. For more details, see section 8 below.  

To add an image to a taxon, first open the respective taxon in the Taxon Editor window. Next you go to 
the menu, Windows -> Show View -> Media. This opens the Media view. Select the taxon name and right 
click on the empty space within the Media view -> New Image Gallery. 

Select the empty media item and add your data in the Details view (which is the Media Editor described 
in section 8.1)..  

For specimens, see section 6.5.4 below 

5.8 Structured descriptive data 
Descriptive data can be handled by simply using simple factual data types, starting with a single text blob 
giving the textual morphological description of a taxon, to more detailed feature definition, for example 
separating the life form or other characters. Truly structured descriptive data, however, do not only 
name characters and states, but also define their semantics. Also, descriptive data stored as character 
matrices allow for a number of advanced features, such as dynamic “natural language” descriptions, 
keys, and descriptions cumulated from specimen descriptions.  

Please refer to the TaxEditor User Manual part 6 (Structured Descriptions) – in preparation. 

5.9 DNA data and alignments 
Please refer to the TaxEditor User Manual part 7 (DNA Data and Alignment Editor) – in preparation 
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6 The Bulk Editor and the Catalogues 

6.1 Introduction 
Catalogues are lists of objects of a given type, e.g. names, specimens, references, persons, etc. They are 
mentioned in many contexts in this manual, in the context of the Bulk Editor they will be described in 
some more detail.  

The Bulk Editor provides easy access to the catalogues, i.e. here you can sort out or clean the catalogues 
independent of the context where they are used. Of course, as explained in the context of the Edit 
button in the Details view, editing a record is inherently dangerous: for example, changing a person’s 
name will change all uses of that name (collector, bibliographic author, etc.).  

For records selected (focussed on) in the Bulk Editor subwindow, the Details view will provide the 
atomised data items, same as in the case of the Taxon Editor and the Factual Data view. 

The tabular design of the Bulk Editor allows to sort the records according to different fields, which is very 
helpful in identifying duplications or inconsistencies.  

With its Search function the records can be restricted to certain values (a full column-specific filter 
function like, for example, in Excel is not yet implemented, though). 

In the Bulk Editor, you can actually delete records from the catalogue (e.g. erroneously imported 
records) – provided that they are not used in some context. You can see where a record has been used 
by opening the Referencing Objects view (in the context menu available by right mouse click or from the 
menu).  

Another important function is deduplication (currently available only for Person/Teams and References: 
you can select several records in the Bulk Editor as Candidates and one as Target for deduplication and 
execute (and save) the change. All relationships of the Candidate records with other objects in the 
database will be changed so that they point to the Target record. Needless to say, that this function also 
has to be handled with great caution. 

6.2 Persons and Person Teams 
Persons and teams of persons are handled in the same catalogue. A Person Team consists of several 
Persons in a defined sequence. Good practice is to create the Person records individually and then 
compose a team only if there are more than a single person, e.g. as author team of a taxon name.  

This catalogue particularly suffers from duplication, mostly due to the fact that during imports (and 
sometimes in input) often many entries are generated that refer to the same persons or teams. The 
parsing routines here are kept on the cautious side, because a purely mechanical assignation may lead to 
errors in attribution. Scrutiny and deduplication of the person names and teams in the database are thus 
a continuous data curation process requiring expertise in the handling of taxonomic data.  
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6.3 References 
References, especially in taxonomy, are complex objects (see section 7) – not only because of their 
inherent bibliographic complexities (books, series, sections, articles, periodicals, informal references, 
databases, ...) but also because of their specific and standardised use in nomenclatural citations.  

In many cases, editorial decisions have to be taken, especially with regard to historical works. How to 
cite Kunth’s publication – as quarto o as folio edition, or both? What about parallel publications? Many 
details that depend on editorial decisions.  

An important fact to remember in this context is that – provided the data are sufficiently atomised – the 
actual output in a portal or – especially – in print output can be configured quite freely.  

As with authors, deduplication and editing of the references catalogue is a frequent task of the 
responsible data curator and can be carried out in the Bulk Editor.  

6.4 Names 
In the Names Bulk Editor, you can edit names in the Details view as known from the TaxEditor. However, 
here you can also find names that have not (yet) received a status of synonym or taxon and you can 
introduce new names without relating them to a classification. 

An original spelling of a name is handled as a name without taxonomic status. If the name is not yet 
included, use the Bulk Editor for Names to create it. Once present, you can select the name in the Details 
view of the Taxon Editor under Nomenclatural Source – Original Spelling. The name than shows up with 
the appended original spelling for the misspelled part of the name in the Taxon Editor subwindow, 
example: Acantholimon ahangarensis Rech.f. & Schiman-Czeika, Fl. Iranica 108: 72. 1974 [as 
"ahangarense"].  

Deduplication of names is not yet implemented. Workaround: Edit all occurrences of the name (e.g. in 
other classification, as a type, etc.) to refer to the same name instance. After that, you can delete the 
duplicates (they should not have referencing objects apart from the standard HomotypicalGroup). 

6.5 Using the Specimen (tree) Bulk Editor  
The TaxEditor has two different Bulk Editors for specimens and occurrences. The Specimen (list) Editor 
presents them in a flat list. The Specimen (tree) Bulk Editor, in contrast, shows the derivation hierarchy of 
the items, that is, a list of derivation trees which are initially collapsed. An item of the type Field Unit is 
the root of each derivation tree. 

The editor can be opened in the menu: Window -> Bulk Editor -> Specimen Editor (tree) 

6.5.1 Adding a new specimen 
A specimen is a derived unit. To create a Specimen (say: a herbarium sheet in the MEXU herbarium), a 
Field Unit has to exist (or has to be created), from which the Specimen has been derived. The Field Unit 
contains all information related to the collection or observation event, like the collector, collecting date, 
field number, locality, etc. Specimens are handled as derivatives that stem from that initial event. 
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To create a new Field Unit, right click in the specimen (tree) content area and select Create Field Unit 

 

A new Field Unit with a cryptic title has been created. The title will be updated to a more meaningful text 
while entering the corresponding data in the Details view. 

Now select the Field Unit and choose Add … > Specimen via the context menu to create a Specimen. 
Enter the details in the right pane and save the editor by Ctrl + s. 

 

6.5.2  Associating a specimen with a taxon 
Presently, this needs to be done via the Factual Data view, see section 
5.6.3 above. 

6.5.3 Editing existing specimens 
Search for all specimen by entering “*” into the Title Cache field of the 
search bar. You should see, for example, any type specimens that 
were entered already.  

Often, as a shortcut in the work process, specimens are entered as 
text in the Cache field. In the Details View depicted to the right, you 
can proceed to atomise the data present in the text, for example by 
copying and pasting them into the correct fields. When you are done 
click the lock icon of the Title Cache field.  
NB: Do not click the lock icon of the title cache field before you are finished. Doing so would set the Title 
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Cache to be automatically generated from the individual atomic fields and you might lose some of the 
textual information.  

6.5.4 Adding Media to specimens (and other Units) 
Don’t confuse Media for specimens with Media Specimens! The latter are media items that serve in a 
function analogous to specimens, e.g. as nomenclatural types.  

Media directly related to specimens or other derived units, like for example scans, photos, graphs from 
analyses etc. can be added to the Media Gallery of the specimen using the Media view. From there the 
can be specified and edited using the Media Editor (see section 8.2, including an example of how to 
handle specimen images from JStor Plants).  

Media that are images are automatically linked to a taxon’s Image Gallery in the portal if they are linked 
to a specimen7. 

6.5.5 Adding Derived Units 
It is possible to add derived units to a derived unit, 
e.g. create a DNA sample from a tissue sample. 
Select the derived uint in the derivation tree for and 
open the context menu (right click). The option Add 
provides the Derived Unit types available.  
Do not use the Media Specimen option here.  

 

 

7 Currently, this is true only for images linked to a Derived Unit, not for those linked to the Field Unit. 
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7 Referencing sources of information 

A Reference (often called Source) in the context of the EDIT Platform is a citation of literature or similar 
sources (including personal communications, databases, websites, etc.). Not included are specimens or 
images, at least not in a direct form (although these may be connected to references). References occur 
in multiple contexts as sources.  

There are two types of references that can be distinguished in a taxonomic treatment: bibliographic 
references and nomenclatural references. The latter can always be related to a bibliographic reference, 
so both are stored together. Specific fields in the Reference object can be used to store the specific 
abbreviated items typical for nomenclatural citations (at least in botany). But note that in the nomen-
clatural citation of a name, the author(s) may differ from the author(s) of the bibliographic reference (for 
example, when the article’s authors are not all named as name authors within the respective 
publication. The nomenclatural authors of a name are thus connected to the name, not to the reference. 
However, entering a nomenclatural reference in the Taxon Editor will create a reference with the taxon 
authors as the bibliographic authors. Deduplication is a curatorial task. 

7.1 Reference type and data items in the catalogue 
The data items that may be entered for a given reference strongly depend on the Reference Type, so 
during data entry, this is always the first item to be selected.  
In the context of a taxonomic treatment, the prevalent types are 
[Journal-] Article, Book, and Section (Book or otherwise), for 
bibliographic sources Database and Web Page are also often used.  
The Generic type typically results from imports or manual entries 
which could not be parsed, because of some pecularity of the 
reference citation (or because the entry of a nomenclatural 
reference did not follow the entry rules, see below).  

All references share a number of data items: 
• Author: An entry of a person or person team from the 

respective catalogue 
• Title: The actual title of the article, book, chapter (book section) etc. – may not apply in certain 

types of sections  
• Nomencl. Title: The abbreviated title as used in the nomenclatural citation for a name 
• Date Published. At least a year should be cited here, but the generic date form allows the entry 

of full dates and a time period, as well as a Verbatim Date (the publication date printed that 
differs from the actual publication date) or a Freetext entry.  

• URI: A web address (https://..., http://...) 
• DOI: Document object identifier – may be entered as a URI or as the actual DOI 
• LSID: Life Science Identifier – a reference to this identifier used in the International Plant Name 

Index IPNI 
• Reference Abstract 
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Other data items are added according to type, for example the Journal and Pages range for an article, for 
a book section the Book containing it, etc. 

7.2 Reference data items outside the catalogue 
Data objects using the reference catalogue may specify  a number of additional data items relating to a 
reference.  

7.2.1 Nomenclatural Source 
The Reference is selected from the catalogue. 
A frequently used data item is the Reference Detail, which gives a location (usually a page) within the 
cited reference.  
Here, the Original spelling used in the publication of the name (and which has been corrected) may be 
specified by selecting it from the Names catalogue. 
A reference to one or more webpages may be made, here to denote the Original Publication. 
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7.2.2 General sources 
References may be cited in context as in the case of nomenclatural references, but basically it is based 
on a general entry structure. E.g. for the source of a nomenclatural status, or that of a specific 
Description Element, the following data items are available:  

A Name in Source can be selected from the names available in the database. This is of particular 
importance for factual data that are assigned to a renamed taxon – for a example a species description 
when the species was placed in another genus.  

Original Information is a text field that can be used to clarify any additional information that should be 
mentioned about the references (this can also - but should not-  be used to enter the name used in the 
source in an unstructured form).  

ID Namespace and ID in Source  are mostly used for data imports, specifying the specific source (e.g. a 
database table) and the corresponding identifier in the source dataset. Both fields can be set to hidden 
in the settings. 
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8 Working with Media 

8.1 Introduction 
Media items like images and photos (but also, e.g., sound files) can be added to various data objects in 
the Platform, such as taxa and specimens. Media are not stored directly in the Platform database. 
Instead, they have to be available under an Internet address (URI) to become part of Platform data. 
However, please note that these URIs should refer directly to an image or to an image embedded into a 
dynamic image viewer, not to a web page containing an image. This is because in the Platform the files 
are used in different ways, embedded in different surroundings and with various resolutions. A website 
is difficult to embed in such a flexible way8.  

Access points for adding and editing Media items in the TaxEditor are  

• Taxa, using the Media view that can be accessed from the Taxon Editor (see section 5.7 above) or 
from the Taxon Bulk Editor 

• Field Units and specimens (as well as any other Derived Unit except Media Specimen), using the 
Media view in the Specimen Bulk Editor (tree) 

• Media Specimen, using the Details view in the Specimen Bulk Editor (tree) 
• The actual Media items with the Media Bulk Editor 
• States in descriptive data Vocabularies (see EDIT Platform Manual part 6) 

For editing, except in the case of Media Specimen and State, the Media Editor is used, which takes the 
place of the Details view once a media object is in focus.  

 

  

 

8 The possibility to add links directly to a taxon (or other objects) is in preparation. These links may refer to a 
website, but they will not be embedded in the same way as images and will not necessarily handle images only. 
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8.2 The Media Editor 
Details of the media items are edited in an editor pane which offers a simple and an advanced mode: 

Simple media editor Advanced media editor 

 

 

(1) This button toggles the media editor pane mode from simple to advanced and back. 
(2) Field to enter the media URI. 
(3) Button to open the image in an external web browser. 
(4) The preview image is shown as soon as the media URI has been entered and if the image is available. 
(5) In the advanced mode it is possible to enter multiple representations of the same media object. 
These can be image files at different resolutions like full size and thumbnail resolutions of the same 
photo. But they may also represent a link to a web application like a dynamic image viewer (see 8.3). 
(6) The mime-type field is usually filled automatically by the TaxEditor. It recognizes common image 
formats correctly and sets the corresponding mime-type like image/jpeg, image/gif, image/png, etc. 
Other mime-types need to be added manually. 
(7) In the advanced mode technical meta-data like size, height, width and further key data are shown. 
These data are extracted from the image, as far as they are available at the supplied URI. 
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8.3 Multiple media representations  
Using multiple representations of the same media is useful when data is published via the EDIT Data 
Portal. Specimen images are often available as image file and also embedded in a dynamic image viewer, 
which allows exploring the photo in the depth of its full resolution. Natural history institutionsoften 
publish their digitized specimens in this dual way.  

In the following we will explain how multiple representations can be used to provide visitors to the EDIT 
Data Portal with a rich user experience. The screenshot from the Data Portal shows a media item from 
JSTOR which has two representations. One thumbnail image representation and a representation with 
the URI to the JSTOR image viewer web-app. 

 

The corresponding URIs can be retrieved from the JSTOR web page 
(https://plants.jstor.org/stable/10.5555/al.ap.specimen.linn-hs1310-54) by doing a right-click on the 
elements depicted below. Commonly web-browsers offer the option to copy the link URI via the context 
menu. 

❶ Thumbnail image URI 
❷ Web-app viewer URI 

Using these URIs, we can create a 
media item in the TaxEditor which 
has two representations and which 
will be appear in the Data Portal as 
shown above. 

 

 

 

Create a new media item in the TaxEditor as explained above and switch the Media Details Editor pane 
to advanced mode and fill the title field with an appropriate label. The Media Representations section, 
which is found in the middle of the pane, already has one element with the according Media 
Representation Part element9. We are using only one of them per Media Representation. 

 

9 Media Representation Parts will be removed from future versions of the TaxEditor.  

https://plants.jstor.org/stable/10.5555/al.ap.specimen.linn-hs1310-54
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Now enter the thumbnail image URI into the URI field ❶ of the 
Media Representation Part. The TaxEditor will immediately 
analyse the image, fill the meta-data fields and show a preview 
of the image. 

 

 

After clicking the plus icon ❷, a second representation is 
added to the media item. You may need to scroll down a bit to 
make it visible and to toggle the parts section open using the 
plus icon next to the section label. Enter the Web-app viewer 
URI into the corresponding field of the second Media 
Representation Part. This time the media meta-data cannot be 
determined automatically from the URI. We need to set the 
mime-type manually in this case to text/html or 
application/xhtml+xml. The latter is preferred for 
most modern web-pages. 
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9 Identifier 

 

10 Name relationships 

 

11 The Referencing Objects view 

12 Extensions, Markers, and Annotations 
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13 Tips and tricks 

13.1 Original spelling 
To add a new synonym that has an orthographical variant as its original spelling, the following way is 
most efficient:  

Example: Moniera micromonnieria (Griseb.) Kuntze [as "Monniera micromonniera"] 

Hit enter at the end of the taxon name or any of its synonyms to create a new line for a synonym. 

Use your text editor (e.g. Notepad in Windows) to create two names: 
Moniera micromonnieria (Griseb.) Kuntze 
Monniera micromonniera (Griseb.) Kuntze 

Paste the two names into the new line, creating two synonyms. Save! 

In the details view, under nomenclatural source, click on the selection of an Original spelling 

Select the misspelled name (here: Monniera micromonniera (Griseb.) Kuntze) from the list, Enter, Save! 

Delete the synonym with the misspelled name in the Taxon Editor. You will get a message that the 
synonym can be deleted, but not the name. That's ok, of course, because we use the name as the 
original spelling. 

13.2 “Liberate” a homotypic synonym in the Taxon Editor 
The space assigned for the synonym list in the Taxon Editor is limited – while you can add as many 
synonyms as you want, the original blank space below the list is used up at some point.  

 
This is a problem when you want to “liberate” a homotypic synonym from its group – which is normally 
done by moving it to that blank space. A workaround is to create a new “dummy” synonym, move the 
synonym from its homotypic group to that synonym, and then delete the dummy.  
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13.3 Nomenclatural Author teams look wrong 
Problem: Bibliographic authors appear in the nomenclatural reference in place of the correctly 
abbreviated ones: 

Nepenthes minima M. Cheek & M. Jebb in Blumea 61: 182. 2016 

instead of  

Nepenthes minima Cheek & Jebb in Blumea 61: 182. 2016 

This occurs when nomenclatural cache is protected in the Author team entry. Close the lock to correct 
this.  

13.4 Eliminate orphaned names 
Names that are not part of a classification (i.e. they are not placed somewhere as taxon names, 
synonyms or misapplied names) can be found by a search. They occur first in the search result list, 
appearing in a different typeset: 

 

These may be records that represent unclassified names, such as original spellings, other orthographic 
variants, or types of genera in floras where the type species does not occur in the flora’s geographical 
range. However, when data are imported these may also turn into duplicates of classified names. This is 
the case with the example given above. 
Before deleting the unclassified name, we do have to make sure that its uses (if any) are correctly 
assigned to the classified name. This is done by searching the name in the bulk editor and scrutinising its 
uses in the Referencing Objects View: 

 



 
User Manual - Tips and tricks  

 

41 
 

All names are assigned to a homotypic group, this is no obstacle. But this name is related to a Taxon 
object and a basionym relationship.  

Looking at the other name: 

 

This is the unclassified name – but it has a NameTypeDesignation relationship. That has to be transferred 
to the other name before it can be eliminated. This is a 3-step process: 
- In the Bulk Editor, change the second name to something indicating that it is the one to be deleted (for 
example, delete the name authors) 
- Go to the related genus (right click on the NameTypeDesignation in the Referencing Objects view and 
open it in the bulk editor) and change the type designation to the first name. 
- In the Bulk Editor, you can now delete the second name.  

13.5 Rename a Classification 
Right click on the name -> Open in -> Classification Wizard. 
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14 Adapting vocabularies and features for use 

The terms used to standardise content entered into the database are highly configurable. To achieve 
productive collaboration, many of the settings are defined for the entire project (“server-sided 
preferences”) and these can only be changed by a person with administrative rights. But various settings 
can also be selected as “local preferences”.  

14.1 Defining the content of vocabularies 
The TaxEditor already comes with many terms and vocabularies, but for specific applications you may 
want to add new ones with the Term Editor. To edit the terms available in a vocabulary, go to the main 
menu Window -> Terms -> Feature or NameFeature.  

14.1.1 Adding a Feature for factual data: 
Menu, Window -> Terms -> Vocabulary -> Feature 

A new window shows the vocabularies [Taxon-] Feature and Name Feature. To add a feature, right click 
on Feature -> New -> Defined Term 

This creates a new term with the label “Untitled” that can be found at the top of the term list. The 
properties of the newly defined term are edited in the Details window. To become visible in the Factual 
Data View, Available for Taxon or Taxon Name must be selected.  

To be visible in the Factual Data View, the feature must be enabled in the Preferences for factual data 
(see 13.1.2. 
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14.1.2 Adapting the available Features for factual data (local and admin) 
Features (pre-defined or new) can be excluded from locally editor or globally.  

To select the features desired, go to the main menu Window -> Local Preferences -> Factual Data -> 
Features. By default, the server-sided settings are active, these include all features defined by the 
editorial board of your project. Click on the selection button below the list and choose Use local settings 
to enable the checkboxes for editing. Now tag the features that you want to be shown when entering 
new factual data.  
Contact an administrator if a you want to define a new Feature.  

14.1.3 Structured specimen data as a feature 
To be able to use the feature “Specimen” in the factual data 
view, this feature has to enabled and to be configured to accept 
structured specimen data. This is done once for a database using 
the Feature editor: Open the Feature Editor via the main menu -> 
Window -> Terms -> Feature and select Specimen in the list. The 
Details view now reveals the choices to define the supported 
data types. Click Supports Individual Association to enable this 
data type and save the editor (Ctrl + s). 

 

14.2 Adapting the language selection for 
common names (local) 

To restrict the number of languages shown, go to the main menu 
Window -> Local Preferences -> Language -> Common Name 
Languages. By default, the server-sided settings are active, these include all standard ISO languages. 
Click on the selection button below the list and choose Use local settings to enable the checkboxes for 
editing. Now tag the languages that should be available for common names.  

14.3 Named area vocabularies for geographic distribution data (admin) 
To select the Vocabularies that are available for structured distribution data go to the main menu Admin 
-> Server-sided Preferences -> Factual Data -> Distribution Data -> Named area vocabularies and tag the 
vocabularies desired.  

14.4 Adapting the options for the distribution status (admin) 
To restrict the number of options for the occurrence status (e.g. in the Distribution editor), go to the 
main menu Admin -> Server-sided Preferences -> Factual Data -> Distribution Data -> Status and click 
Status Selection to open the Dialog which allows for defining the selection of status for all or for specific 
areas.  
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14.5 Enable using multiple languages for Factual Data (admin and local) 
To create a multilingual user interface in the portal, it is necessary to enter some factual data items in 
multiple languages. To enable multiple language support, go to the menu Window -> Local Preferences -> 
Language -> Multi-Language Support: check Enable Multiple Language Editing Capability 
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15 Error handling and feedback 

For Installation problems please refer to part 1 of the manual. 

Other software errors will be indicated by an error message. Please help us to improve the program by 
copying the error and sending it to the Platform team (EditSupport@BGBM.ORG). 

The error text itself may give you some indication of what had happened. For example, if you find an 
indication like "NoHttpResponseException" the error was not caused by the software, but the 
connection with the server was broken or interrupted. Usually, you can just continue to work, if 
necessary use the Re-connect function in the General menu.  

mailto:EditSupport@BGBM.ORG
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16 Glossary  

 

 

Cache - For many data items the platform provides a concatenated view of the atomised elements of the 
item – e.g. a species name that consists of the separately stored elements Genus, Species epithet, and 
Author team is shown in the Name cache as a single string that is automatically assembled from the 
atomised elements. The automatic assembly can be disabled and content can be written 
directly into this field; the content is protected by means of clicking and opening the little 
padlock on the right. This may be useful for preliminary entries or in cases where data is 
pasted or imported from non-atomised sources. However, the disadvantage is the loss of connection to 
the catalogues (e.g. the generic names already in the database) and consequently the lack of 
standardisation of data elements. The output, e.g. in the data portal, will always use the data shown in 
the cache.  

Characters – In the context of the EDIT Platform, Characters are Features that refer to the atomised 
description of an organism (e.g. morphological characters). The Edit Platform uses the three-part 
representation that was first suggested by Diederich (1997): Property – Structure – Character state for 
the processing of descriptive information; however, the two-part construct can also be used by defining 
the Character (property + structure) as a Feature and the state as the feature’s value. 

CDM Database - See Database. 

CDM Instance - See Database 

CDM-Light – A set of tables that can be exported from the Database. See Manual-EDIT-Platform-
Appendix-CDM-Light* for details. 

Classification - A Classification in the context of the CDM is a taxonomically coherent treatment of 
names, classifying them into names of taxa and their synonyms and placing the taxa into a taxonomic 
hierarchy. Within the same Database, the same names may be used in different classifications, and the 
same name may be accepted as a taxon name in one and treated as a synonym in another. Also, taxa 
may be reused in different classifications, which implies that their relation to synonyms as well as 
attached Factual Data are the same. For example, we may use the same species and genus level 
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treatment of taxa in two different systems of suprageneric classifications that may have different 
circumscriptions of families and orders.  

Database - A separate platform database (CDM store, CDM instance), usually with specific taxonomic 
and/or geographic focus and a common set of editorial rules. Examples: Cichorieae, Caryophyllales, Flora 
of Cyprus, Fauna Europaea. It is possible to create different data portals on a single platform instance 
(e.g. a country checklist based on the Euro+Med PlantBase database).  

Derived Unit – A unit in the derivation tree stemming from a ->Field Unit, e.g. a specimen, DNA- and 
tissue-samples, sequences, cultivated living organisms, etc. The tree is rooted in a Field Unit, which is in 
our case the organism in the field with the respective collection event data. All Derived Units can be 
traced back to the Field Unit.  

Dialogue (Dialogue box) - A small window in the user interface that communicates information to the 
user and prompts them for a response. 

Doubtful - There are two indications of “doubt” in a name’s standing that can be indicated by a flag: 
Doubtful status and Doubtful placement. 
The Doubtful status flag is set in the Details view for the name of a taxon, synonym or misapplied name. 
It indicates that there exists a caveat in accepting the name as taxon or synonym with its accompanying 
nomenclatural status. It is generally indicated as an interrogation mark “?” in front of the respective 
name. There is no option to comment the status directly nor to state a source reference for its setting. 
The Doubtful placement flag is set in the Taxon node dialogue. It indicates a caveat in the assignment of 
a taxon (!) to its place in the taxonomic hierarchy. Here, a free text to discuss the problem and the 
source reference of that statement and placement can be cited. The doubtful placement is indicated by 
two interrogation marks “??” in front of the taxon name in the Taxon Navigator.  

EDIT Platform - The EDIT Platform for Cybertaxonomy is a software suite supporting the entire 
taxonomic workflow. Moreover, the Platform is a powerful information broker for a broad range of 
taxonomic data providing solid, open and well documented interfaces including a Java programmer's 
library and a CDM Rest Service Layer. 

Factual data (facts) - Factual data encompass all data items that are used to describe or assign 
information to a taxonomic object (i.e. to a taxon, a name, or to a member of the unit hierarchy – e.g. a 
specimen). 

Factual data category – see Feature  

Factual dataset – A collection of features and facts that may be assigend to a common source reference.  

Feature - Factual data are classified into Features. Examples include “Description”, “Chromosome 
number”, “Ecology” “Distribution”, “Notes”, etc. – essentially anything that appears as a subtitle in the 
text following a taxon name in a Flora or Monograph can be defined as a Feature. But features may also 
apply to names themselves (e.g. nomenclatural notes) or to specimens.  
Features may be simple, i.e. consisting only of a text with accompanying references, or complex. 
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Complex features are usually supported by catalogues, e.g. the hierarchy of geographical areas and the 
occurence status that characterises a distribution record.  

Feature Tree – a term tree that represents a selection of features that are used for display in the portal.  

Field Unit – An object in the field (an organism or population) from which samples or images were taken 
to produce ->Derived units. Connected to the field unit is the information of the collection or 
observation event, including the geographic location, environmental data, collector-team, etc..  

Name (“scientific name”) - The EDIT Platform’s CDM sharply distinguishes between nomenclature and 
taxonomy, although the issues sometimes overlap. Nomenclature follows the respective Codes. Names 
have a defined structure according to their rank. They can have a specific nomenclatural status (e.g. 
“invalid”) and may be related to other n ames (e.g. “is replacement name for”). Further nomenclatural 
data include the name’s author and the nomenclatural reference citation (i.e. the reference to the 
name’s publication); both are traditionally abbreviated, at least in botany. Names are grouped into 
homotypic groups, normally consisting of all names that go back to the same nomenclatural type.  

Node - See Taxon node. 

Pane - An area in the TaxEditor to which subwindows (views and editors) can be attached. The main 
working area of the TaxEditor is split into multiple panes. 

Perspective - Pre-sets of subwindows (views and editors) arrangements for specific tasks. Perspectives 
can help users to focus on a taks. 

Placement - This term refers to the place of a taxon and its synonyms (or a name – see below) in the 
taxonomic hierarchy, or more precisely, in a specific Classification. The assignation of a taxon to a higher-
ranked taxon is the act of placement. Placement is thus a property of a Taxon Node. The latter can 
represent taxa, but also pseudotaxa, excluded names and taxa, and unplaced names and those of 
uncertain application. These properties (excluded, unplaced, uncertain, but also doubtful placement) can 
be indicated by flags set in the Taxon Node Dialogue and can be explained or commented upon in a free 
text note that can carry a source reference.  

Publish flag - A taxon and related information can be set to be published in order to make it publically 
visible in the Data Portal or in other publication formats like CDM Light. 

Excluded, Uncertain, Unresolved - Excluded names and taxa are treated as taxon nodes to ensure their 
visibility in the resulting taxonomic treatments, but are not included in the core taxonomic hierarchy. 
They may be treated under separate pseudotaxa and/or be indicated by setting a placement flag, with 
the possibility to comment upon the reason for the exclusion from the treatment. These reasons, and 
their treatment in the database are largely editorial decisions. For example, in a flora treatment, taxa 
may be excluded because of they do not occur in the flora’s geographical scope but have for some 
reason to be mentioned. In a monographic context, synonyms that actually do not belong to the taxon 
treated (but, e.g., have been ascribed to a genus in the treatment) may be marked as excluded. Names 
may be excluded as, for example, herbarium names (but these may also be included in the synonymy as 
invalid designations if their taxonomic context is known, the same applies to other nomina nuda).  
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Occurence – A species occurrence record, i.e. a specimen field unit or an observation. 

sec.-Reference – The source reference for the circumscription (not the placement) of a taxon.  

Specimen - In the underlying Common Data Model (CDM), specimens are treated as part of a derivation 
tree that may include various objects such as DNA- and tissue-samples, sequences, duplicate specimens, 
cultivated living specimens, etc. The tree is rooted in what we call a Field Unit, which is in our case the 
organism in the field with the respective collection event data. All Derived Units can be traced back to 
the Field Unit. 

syn.-sec.-Reference – The source reference for the attribution of a name as a synonym to a specific 
taxon.  

Tab – One of several Subwindows occupying the same space and selectable by a projecting title “tab”. 

Taxon - In the context of the Platform, a taxon is class of organisms with a specific name and rank in the 
general taxonomic hierarchy. A taxon may have homotypic and heterotypic synonyms. In contrast to 
synonyms, a taxon may have factual data assigned to it, such as description, distribution, uses, etc.  

Subwindow - This can be a view or an editor in the TaxEditor application. Subwindows can be minimized, 
maximized or detached as floating subwindow.  

Supplemental data view – An extension of the Details view for additional data, often of a more technical 
nature.  

Taxon node - When a taxon is included into a classification, a taxon node is created. In the TaxEditor, 
taxon nodes are visible as the names you see in the Taxon Navigator.  

Unit – An object in the tree formed by collection objects and their derivatives, such as specimens, 
samples, and images. 

View – a secondary subwindow whose content is determined by the focus set in another subwindow. 

Window – The space on the monitor occupied by an instance of an application – e.g. the window used by 
the Taxonomic Editor 
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